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Overview
Overview

FORCAM provides companies with all the information they need to control and optimize their
production. The modular lloT solution FORCAM FORCE MES FLEX is as flexible as the needs of
customers. With a variety of production apps, FORCAM helps companies to make their processes
more transparent and improve their workflows. In this way, companies create the basis for
optimization measures and sustainable success, thereby ensuring their competitiveness.

FORCAM is always endeavored to optimize the solution FORCAM FORCE MES FLEX further, to enrich
it with functions, offering customers consistent growth and greatest possible use. For this purpose,
several releases are published throughout the year.

This document lists functions that have been added or changed during the 5.12.21 release. It serves
as an overview of the most important features to use FORCAM FORCE MES FLEX in the best possible
way.

Detailed descriptions of the individual functions can be found in the respective product
documentation.
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Common

Common

Support import of .pfx files for certificate

Affected module Affected area NI

FFSetup Import of HTTPs Certificates Changed

HTTPs certificates are frequently provided in a .pfx format. These certificates are then manually
imported into ffsetup after converting them to .jks format. However, this conversion process is
deemed unnecessary and manual. Now, ffsetup is enhanced by allowing the direct import of .pfx
certificates and implementing internal automatic conversion to both .jks and .crt fomats for Nginx.
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Workflow Control

Workflow Control

Workplace list in SFT is collapsed by default

Affected module Affected area NI

Workbench/SFT Configuration Changed

Path: Workbench > Configuration > Shop Floor Terminal

In SFT, the Workplace list is primarily unused because the majority of terminals have only one
workplace assigned. As a result, the default behavior has been modified to collapse the workplace list
by default.

When adding a new Operation View to a template the default value of Open workplace list initially is
false.

Template Editor (Use Case 2: Data Collection Acquisition with Production Orders/Operations)

dentifier

List of Base Pages

~ Operation View
~ Use Case 2: Data Collection Acquisition with Name @ Operation Yiew
Status History (Operating State History) Description @ Operations Page
Operation View (Operation View) - Root E Height Upper Table 50%
Reports (Browser) Width of the workplace 39%
Width of the Operation List 155%
Automatic update cycle for complete basepage [M5] 30

Open workplace list initially

Base page configurat'lon A [ Automatic Update Cycle for Detail View [sec] 60

~ Operation View (Operation V - Root B - - -
peration View (Operation View) - Root Bast Operations list sorting ascending order - Keep empty values at bottom

> Bution Bar < Barcode Scan Configuration o

Warkplace table 5 Search operations on all terminal workplaces

Operation Table > Terminal identification

Operation Details > NC/DNC Configuration

Use Case Templates

In all of the use case templates, the configuration of Open workplace list initially is set to false.

@ No behavior changes on existing templates. If changes are required, it can be made manually.
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Workflow Control

Expandable & collapsible operation detail view in SFT

Affected module Affected area Status

SFT Operation Detail View Changed

In the Shop Floor Terminal, the usable area for the Operation Detail View is maximized by extending
the order area (Workplace & Operation grids) to allow for minimization.

Path: Workbench > Shopfloor Terminal Configurator > Basepage Operation View Ul

As shown below, new configuration for base page Operation View Ul is introduced to
expand/collapse the order area (Workplace & Operation grid area):
=  Operation View > Full screen mode for detail view: Boolean configuration to decide if the

order area (Workplace & Operation grid area) is expanded or collapsed initially after user has
logged in. Default is false.

If the configuration, Full screen mode for detail view is set to false, means that the order area is
expanded and Operation Detail area will have relatively less space.

If the configuration, Full screen mode for detail view is set to true, means that the order area is
collapsed and Operation Detail area will have relatively large space.

List of Base Pages Y | centifie Qv A |Value

v Operation View
v Use Case 2: Data Collection Acquisition with Prc

Name @ Operation View
Status History (Operating State History) Description @ Operations Page
Operation View (Operation View) - Root Bast Height Upper Table 50%
Reports (Browser) N

Width of the workplace 39%

Width of the Operation List 155%

Base page conﬁguration A Automatic update cycle for complete basepage [MS] 900
Automatic Update Cycle for Detail View [sec] 60

v Operation View (Operation View) - Root Bas¢ *
Open workplace list initially

> Button Bar .

Workplace table 5 Operations list sorting ascending order - Keep empty values at bottom
Operation Table Full screen mode for detail view

Barcode Scan Configuration <

Operation Details %

Search operations on all terminal workplaces
Activity steps A =
> Terminal identification

> NC/DNC Configuration

FFWorker

Operation View Ul
Base page Operation View is extended to handle the possibility of providing maximized space to be
used for Operation Detail area.

Below are the extensions done for the base page:

— A header above the order area is introduced to enable the user to maximize (or restore) the
Operation Detail area dynamically.
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Workflow Control

= A new JavaScript variable DPV_fullScreenMode is introduced providing the information (to
be used in the HTML structure) regarding the current mode of the Operation Detail area. This
JavaScript variable can be used to design a responsive Operation Detail area depending upon
the customer use case:

= If the current mode of the Operation Detail area is maximized then the value contained
by the JavaScript variable DPV_fullScreenMode is true.

— If the current mode of the Operation Detail area is not maximized (Regular or Restored
view) then the value contained by the JavaScript variable DPV_fullScreenMode is false.

Maximized Operation Detail area:

FORCAM FORCE™ Operation View [90270] & English (GB)

Workplaces & Orders

Total Quantity Target Quantity Remaining Quantity (Operation) Operation state

0Stk 2000Stk2000 Stk@Not Assigned
l;uanmy 2000 - Order / Operation Operation Description
oo 9 1001000100/ Lorem ipsum dolor sit amet, consetétur sadipscing elitr,
I3 33:30:00 0% 0010 sed diam nonumy eirmod tempor invidunt ut labore et
~ o Start Operation
Time Remaining dolore
33:30:00 magna aliquyam erat, sed diam voluptua.
Mat.No. / Material Scheduled Start Date Planned end (operation)
M-15223675 06/07/2016, 07/07/2016, 23:30:00
AFTV-Vertikal-Kettenforderer VKF 600 06:00:00
Target Setup Time Actual Setup Time
(Operation) %
00:10:00
Target time per unit  Time per unit
00:01:00

Production Resource Type

M-705548 - Tool M-705548
M-533425 - Tool M-533425
M-579519 - Tool M-579519
M-289563 - Tool M-289563

M-301949 - Tool M-301949 )
Reporting

Status History

Use Case 2: Data Co.. 15:42:30

Restored Operation Detail area:

FORCAM FORCE™ Operation View [90270] & English (GB) -
Workplaces & Orders
Order Operation |Material No. " Target Quantity | Yield Quantity |Scrap Quantity ework Quantity | Time Per Unil | Planned Start Phase
»1001000100 0010 M-15223675 2000 0 0 0 1.00 06/07/2016, 06:00:C Released
1001000101 0010 M-15223675 2000 0 0 0 1.00 06/07/2016, 06:00:( Released
’é 1001000102 0010 M-15223675 2000 0 0 0 1.00 06/07/2016, 06:00:( Released
§ 1001000103 0010 M-15223675 2000 0 0 1.00 06/07/2016, 06:00:C Released [l Start Operation
Total Quantity Target Quantity Remaining Quantity (Operation) Opelailcn state
0Stk 2000Stk2000 Stk(v/Not Assigned
Quantity -
0 2000 oo Order / Operation  Operation Description
- pone 2 1001000100/ Lorem ipsum dolor sit amet, consetetur sadipscing elitr,
% 33:30:00 0% 0010 sed diam nonumy eirmod tempor invidunt ut labore et
Time Remaining dolore
33:30:00 magna aliquyam erat, sed diam voluptua.
Mat.No. / Material Scheduled Start Date Planned end (operation)
M-15223675 06/07/2016, 07/07/2016, 23:30:00
AFTV-Vertikal-Kettenférderer VKF 600 06:00:00
Target Setup Time Actual Setup Time
gs-ef(;?go 2 Reporting
Target time per unit  Time per unit
00:01:00 -
Production Resource Type
M-705548 - Tool M-705548 SRS
M-533425 - Tool M-533425 -
Use Case 2: Data Co... 15:43:25
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Workflow Control

The JavaScript variable DPV_fullScreenMode:

MES FLES

NSUrIpT LypeS— LSAL/ javasoripl 31 C— 21 iwurnel

JEVESLI AP/ LG €5 PIugill UOLOLOUSLd L4 U Lil: JD

sNpserspos

<style type="text/css">
body {overflow:auto;}
#H1 {font-family:

arial; font-weight: bold; color:

<script type="text/javascript">
var DPV_contextPath = "/ffworker";

Do TR 5 R ALY ok 1 2, 0 ne

lvar DPV:fullScreenMode = "false

- ma;
AmitNB";
"en_GB";

[
DPV_hostName
DPV_locale =
DPV_requestURL =
DPV_scaleFactor = "100.0";

DPV_serverName = "amitnb";

DPV_serverPort = 11443;

DPV_serverProtocol = "https://";
DPV_servletPath = "/reportserver";
DPV_timezone = "Europe/Berlin";
DPV_timezoneRawOffset = 3600000;
DPV_timezoneUseDST = Boolean(true);
DPV_timezoneinDST = Boolean(true);
DPV_useThousandSeparator = Boolean(false);
var DP_WORKPLACE = new Array();
DP_WORKPLACE[@] = new Object();
DP_WORKPLACE[®].derivedColor = "#B6BABF";
DP_WORKPLACE[0] .derivedColor$blackorwhite =

R

"#000000" ;

td {font-family: arial; font-weight: bold; color: grey; font-size: 100%; line-height: 1.2em;
grey; font-size: 80%; line-height: 1.2em; width: 100%; margin: @; }

#V1 {font-family: arial; font-weight: bold; color: black; font-size:
#V3 {font-family: arial; font-weight: bold; color: black; font-size:
#V2 {font-family: arial; font-weight: bold; color: black; font-size:
table td, table td * {

vertical-align: top;
}
</style>
</head>
<!-- insert variable definitions BEGIN -->

VQtpLyJdl2KPapwgmnxePLfloQGrPklohdepFs1RjQpZDKhPBWttvzOMosDSEhROASCUQ8 _AwB85SHL3IXhZ1S7C0s

"https://amitnb:11443/ffworker/reportserver;jsessionid=DD47E8129E2CA468FBI5B633FABCE324";

DP_OPERATION[O]

DP_OPERATION[@].
DP_OPERATION[@].
DP_OPERATION[@].
DP_OPERATION[@].
DP_OPERATION[@].
DP_OPERATION[@].
DP_OPERATION[@].
DP_OPERATION[@].
DP_OPERATION[@].
DP_OPERATION[@].

var DP_OPERATION =

new Array();

= new Object();

bookedReworkQuantity = "@";
bookedReworkQuantity$noOfDecimalPlaces =
bookedReworkQuantity$unit = "Stk";
bookedReworkQuantity$value = 0.0;
bookedReworkQuantity$valuePreformatted = "0";
bookedReworkQuantity$valueRounded = 0.8;
bookedScrapQuantity = "@";
bookedScrapQuantity$noOfDecimalPlaces =
bookedScrapQuantity$unit = "Stk";
bookedScrapQuantity$value = 0.0;

H

H

margin: 0; }

400%; line-height: 1.2em; width: 120%; margin: @;
300%; line-height: 1.2em; width: 120%; margin: 0;
120%; line-height: 1.2em; width: 120%; margin: ©;

e e
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Planning

Planning

FFScheduling extension: Fixing started operations to a workplace

Affected module Affected area NI

FFScheduling Master Data New

Path: FFScheduling client > Master Data

When configured, interrupted operations will be treated as if they were fixed to the workplace on
which they ran before. All orders have to be refreshed after the update. The configuration is in the
system master data.

= English: Fix interrupted operations on workplace
= German: Unterbrochene AVOs auf Arbeitsplatz fixieren
= French: Fixer opérations interrompues sur poste de travail

Editor

E Master Data

vy 2 e ek R E |G

Mame Value

-Default Font Size 4| A

- Site Restriction

- Dperation Control Keys

- Alternative Operation Contral Keys

- Unattended Operation Control Key
--Planning Base Workplace
- All workplaces of the group are alternative

- Order Comment Field

--Target Setup TII'I‘IEhFiE|L'.|
- Default Transport lﬁ%ount
- Transport amaount refers to production stz

+- Queue Time Options =
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Planning

Editor

fEd systemdaten vy

Mame

- Default-Schriftgrafe

- Einschrankung auf Werk

- Steuerschiissel der AVO's

- Steuerschiissel der Alternativ-avo's

- Steuerschiiissel fiir bedienerlose AVO

- Planungsgrundlage

- Alle Arbeitsplatze der Gruppe sind Alternativer

imatiabdaiisals

- Unterbrochene AVOs auf Abeitsplatz fixieren

B 18-y e

- Auftrags-Kommentarfeld

- Gollristzeit-Feld

- Standard Weitergabemenge

- Weitergabemenge bezieht sich auf Produktion:

- Transportzeit Optionen

HEd Données du systéme v g >

2 |

B | aews | E | &

Mom

- Taille de police par défaut

- Restriction & la division

- Clé de commande des opérations

- Clé de commande des opérations alternatives

- Clé de commande des opérations sans surveilance

--Base de planification

- Tous les postes de travail du groupe sont des altern:
. ) -

- Fixer opérations interrompues sur poste de travail
T TR T T

--Champ des commentaires de ['ordre

- Champ du temps de préparation théorique
- Quantité de transfert standard
-La quantité de transfert se référe au début de prody

-Options de temps de transport

Valeur
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Page: 10/27



MES FLES

Planning

Improved access of availability in Digital Planning Board

Affected module Affected area Status

Workbench Digital Planning Board Changed

In the ORG Hierarchy, the attribute workplace availability factor now uses percentage values (e.g.,
80) instead of factor values (e.g., 0.8)

Attributes: 90270 - BO7

# | Attribute Name Description Value Inherited Overwritter | Will Be Inhi | Read-Only
1| Language Language - de-DE -

2 | Time zone Time zone = | (+02:00) Europe/Berlin - Central Eu =

3 | ERP Key ERP Key - | 100-9000-9000 -

4 | Personnel ERP Key Personnel ERF | ~ Selected (1), Available (0)

5 | Overhead Cost ERP Key Overhead Cost ~

6 | Cost Center Cost Center -
7 | Operation Overlap Operation Over v
¥ | 8| Availability are permissible. ¥ 200

Awvailability of the workplace as percentage
value. Values > 0 and comma values are
permissible.

oK Cancel

Removal of Consider availability (workplace) from Digital Planning Board

In the Digital Planning Board's configuration under Planning Mode, the option Consider availability
(Workplace) has been removed. Consequently, when a user has defined availability in the ORG
Hierarchy, that value is now directly considered for recalculation.

Edit Configuration o)

Planning Mode Identifier Qv ~ |Value

Monitoring Mode ¥ Planning Mode

Columns Operation Table Restriced Operation Areas Selected (0), Available (3)
Gantt chart Operation elongation areas Selected (3), Available (0)
Bar Text Gantt Chart Quantities for Remaining Time Calculation Selected (2), Available (2)
Workplace Tooltip Gantt Chart Close Gap Automatically

Operation Tooltip Gantt Chart Display Overlap Status v

Color Models Check group capacity

Columns Capacity View Check operation sequence v

Search fields Consider individual production time per unit v

General Consider availabili v
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Platform & Connectivity

Platform & Connectivity

NC-File Transfer between machines

Affected module Affected area NI

Workbench Production Data Management New

In the context menu of the source NC Controller is now possible to select Exchange file directly.

#A > Production Data Management > PDMLlogs > State Monitor NC Controllers

NC Controller-Log X X FDM User Log X State Monitor NC Controllers X

State Monitor NC Controllers

NC Controller State Connection State | Element File Name Transmission Dire¢ | Bytes Transmission activ | Error Message Log]
M100
» M200 ]

Start NC Controller Communication F
Restart NC Controller Communication
Stop NC Controller Communication
Set Log Level
Send auxiliary data to NC controller
Ibl$ffworkbench$dncMachineStatusMonitor$cmdReceiveAuxiliaryData

Navigator

The user is provided with the option to select the target NC Controller. Additionally, if the NC
Controller does not utilize files, the user is required to input a filename.

—_—————
Exchange file directly

Source NC controller M200
File Name (With File Extension) filename.nc
Target NC controller M100 >

OK Cancel

To initiate the exchange, the user is required to commence the receiving process on the destination
NC Controller. Subsequently, the sending process on the source NC Controller must be initiated.
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Platform & Connectivity

Request program handling

Affected module Affected area Status

PDM/DNC PDM/DNC New

The new variant of Simple Request File Handler is introduced in the PDM for Request program
handling. With the help of this variant even with minimum configuration, it is possible to request the
NC file from machine.

With Simple Request File Handler Request program handling:

= Only the program number (which is stored as packet key 2) is provided resp. necessary as
single line in the request file.

= There is no file upload with this handler, i.e., communication machine = PDM. Thus, there is
no type of entry (defining NCP, OPT etc.).

=  The system lacks an element version number feature. Instead, it consistently provides the
highest available element version when multiple versions exist.

—  Only elements of the configured “Transferable ELement Sources” (example:FDM and EXT)
are provided. Additionally, to the “Standard” variant, transferable element NC-Types can be
configured.

As an example, see the following request file, specifying packet number “81759”:

1 %#R81759

The packet number gets parsed via RegEx as usual, according to the given configuration.

Workbench
An additional configuration variant called Simple Request File Handler is available. It is shown in the
example below:
—  Configuration to read the packet number (represented with program number) from line 1 in
a request file, as packet_key?2) variable.
= NCtypes, only for variant Simple Request File Handler, a new attribute is introduced. It helps
to identify the correct NC file to transfer to machine.
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Platform & Connectivity

Mitsubishi MDC and DNC plugin

Affected module Affected area Status

FORCE MES FLEX FORCE MES FLEX New

A new MDC and DNC plugin to connect Mitsubishi controllers is created.

DCU controller configuration

Path: Workbench > Master Data > Workplace > Template Configuration / Workbench > Master Data
> Workplace > Workplace Configuration

Configuration parameters:

Parameter Description

Address and port used for connecting from the DCU to the
MitsubishiService

Address and port used for connecting from the
MitsubishiService to the machine

Address:Port (Service)

Address:Port (Machine)

Connection ID / Host name / NC

. Parameters for the connection to the machine
Control Unit number

NC system type Type of the Mitsubishi machine

Connection timeout in ms (Service / Timeout on connection to the MitsubishiService / to the
CNC) machine.

M > MasterData > Workplace > Template Configurations

Template Selection Tree

AR
DCU Controller: Mitsubishi
Templates Q*
> |0BoxSeriptTemplateStateQty &t & [ Controller Configuration

> I0BoxScriptTemplateStroke v Mitsubishi Deactivate Controlle [N

v Mitsubishi alarm@ Template Name | Mitsubishi
DACQ Configuration alarm1 Type  MITSUBISHI -
DACQ Script EETERSEITS ype | MITSUBISHIPROT -
DCU Controller Eroa=N ey Comment
DCU Head Controller EIEIERAY

Machine Sequence
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Platform & Connectivity

ﬂ‘ » MasterData » Workplace » Workplace Configuration Controller Configuration

Controller Configuration

v Mitsubishi100

alarm0 DCU | DCUA -
alarm1 Controller | Mitsubishi100

machinePositions MName Mitsubishi

programNumber Type | MITSUBISHI T
statusRun Bus Type | MITSUBISHIPROT 7

localhost61683
127.0.0.1:683

¢ Connection 1D / localhost/localhost/1

Navigator

25000425000

DNC configuration

Path: Workbench > Production Data Management > PDM Configurations > DNC Machine
Configuration > Plug-in for NC Controller Communication

Configuration parameters:

Parameter Description

Connection ID Connection ID (parameter of the machine conneciton)
Address (Service) Address of the MitsubishiService program

Port (Service) Port of the MitsubishiService program

Type of the Mitsubishi machine:
5 EZNC_SYS_MELDAS700L

6 EZNC_SYS_MELDAS700M

NC system type 7 EZNC_SYS_MELDASC70

8 EZNC_SYS_MELDASS800L

9 EZNC_SYS_MELDAS800M

10 EZNC_SYS_CNCC80

NC Control Unit Number Control Unit Number (parameter of the machine connecion)

Connection timeout in ms (Service / . . .
Timeout on connection to the machine

CNC)
Host name Host name (parameter of the machine connetion)
Log level of the MitsubishiService (FATAL, CRITICAL, ERROR,
Log level
WARNING, INFO, DEBUG)
Machine directory DNC program directory on the machine
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Platform & Connectivity

# > Production DataManagement > PDM Configurations » DNC Machine Configuration

DNC Machine Configuration

NC Controller Selection | M100 - =

DNC Machine Configuration dentifier Qv ~ |Value

Plug-in for NC Controller Communication ~ Mitsubishi
Connection ID localhost
Address (Service) localhost
Port (Service) 61,683
Address (Maching) 127.0.01
Port (Maching) 683
NC system type [

MNavigator

NC Control Unit Number 1

Connection timeout in ms (CNC) 25,000

Host name EZNC_LOCALHOST
Log level INFO

Machine directory MO1\PRG\USERY,

Short Term Process Data in SQL DB

Affected module Affected area Status

FFWebservices/SFT/FFWorkbench/ | FFWebservices/SFT/FFWorkbench/

FFSetup FFSetup New/Changed

Until now, MES FLEX exclusively supported Mongo DB for energy data management, catering to
smaller customers or those with limited energy data requirements. However, a significant
enhancement has been introduced, enabling the processing and evaluation of measured values
within SQL Server or Oracle DB environments.

This upgrade enables triggering process data via APIs, facilitating its utilization in the Worker-Client
interface for various purposes such as Operation detail view, enabling/disabling button, etc.
Furthermore, users can create custom reports and visualizations to closely monitor the data.

Process Data Lifecycle

— Measured values are stored both in table for current values and table for historical data.

—  Current value of measurement will be overwritten with next value (but is still present in the
historical data).

—  History of the values of a measured value is only kept for a certain configurable period of
time.

— History data can also be transferred to a separate archive database (not part of the standard
solution but a project specific extra solution)
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Platform & Connectivity

Nginx (New Application)

Nginx is a new application in the Force-MES. Nginx acts as a middleman between two servers (SFT
and Webservice, presently). It functions as a cache and reverse proxy, meaning it stores frequently
accessed data and forwards requests to the appropriate server, improving performance and
efficiency.

Nginx is used as a cache and reverse-proxy server in the force MES that’s currently sits/placed
between the SFT and Webservices. It's main task is to cache the response of the request and return
the response back in case of same request is received again as well as it also has hidden the
Webservices URL and details.

Nginx installation

Nginx as an optional installable application is available via ffsetup. One can select the application in
the ffsetup applications and install it by providing the necessary configurations like protocol, port and
backend server url. It is recommended to use the https and secure port 443 which are also defaults.
The webservice URL also to be configured accordingly, the default is local webservices URL. SFT
communication URL shall also be changed to the Nginx host and port.

ActiveMQ
Nginx Protocol https
Database
Email Nginx Host localhost
FORCE Nginx Port 443
General
Nginx Upstream URL https://127.0.0.1:24443
Ignite
InfluxDB

Licence Management

v Nginx

FFWorker communication APl configuration :- Defaults are (http, localhost, 24080, ffwebservices)

Communication API Protocol htt|]5|

Luhn'un cation APl Host localhost
Communication API Port 443
Communication API Path ffwebservices

FFWebservices

Command and Callback API — Short Term Process Data
A new API has been introduced to receive Short Term Process Data. It can be found under the
“Command API” “Short Term Process Data” section.
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Platform & Connectivity

Short Term Process Data A

/shortTermProcessRecords Add process data v

JSON example:

{
"timestamp": "2023-05-17T14:20:39.085Z",
"measurement": "temperature",
"measuredValue": 1.0,
"measurementSource": "MACHINE_1",
"domain": "GENERIC",
"additionalText": "more information"

}

The domain can be set as one of the following:
= GENERIC
= WORKPLACE
= OPERATION

If the domain is WORKPLACE or OPERATION, the measurementSource has to be the UUID of the
Workplace or the Operation.

Shopfloor Terminal

Dark activity step - Query current process value
A new dark activity step has been introduced to query one or multiple short-term current process
data measurements. Each requested measurement is identified by its name and source (its key).

There are two ways how desired measurements can be defined, either one or both together can be
used to:

— define measurements explicit, i.e., with its keys.

— domain object related measurements (Workplace, Operation), i.e., for given domain objects
appropriate measurement-names could be given.
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MES FLES

Identifier Qv ~ |Value
~ Query current process values
Activity step name @ Qry process dat

> Configuration of Execution Conditions

<

When cancelling continue reporting procedure

w Inputparameters

(2) List Elements

Parameter Assignment

~  Parameter (EVERY)

= % Current process value names to query (EVERY)

>

Parameter Assignment

Workplace (WPL)

- —) Current process value sources to query (EVERY)

v Output parameters

(1) List Elements

Parameter Assignment

Parameter 10 (EVERY)

= 6 Current process values (EVERY)

Current process value names to query

[domain_nameCfg1, domain_nameCfg2, domain_nameCfg3]

Add Activity Step (Behind)
[
dentifier

Q @ querycurrent

¥ QueryCurrentProcessDataMeasurementsActivityStep

<
Contained Literals:

dentifier Value
Activity step name @

Name
- Q &

Query current process values

[1/159]1 ¥ Clearfiter Y Suspend Filter Filter Row
Description
ok ! -

= |t short-term process values (with or without domain object reference). ~

Query one or more current short-term process values (with or without
domain object reference).

OK Cancel

Figure: Steps configuration within SFT > Template Editor:

Enhanced Operation Detail View

Path: SFT > Operation View basepage > Operation Detail View

The generation of Operation Detail view is now extended to support the display of data received for
the configured standard reports (report configuration can be done in Workbench > Template Editor).
The configured report is called via BridgeAPI and the response is made available to Operation Details
HTML. This data can be used to display in plain string format or can be displayed in formatted tabular
or any other visual data format like graphs, charts etc. as shown below:

Force-5-12-21-Functional-Release-Notes

Page: 19/27



Platform & Connectivity

FORCAM FORCE™ Operation [ManualSeq-20016]

Workplace
90270

BO7T

M-15223675

Huber, Marion

AFTV-Vertikal-Kettenférderer VKF 600

Assigned Personnel (Operation)

Text Order Operation Material No Target Quantity | Yield Quan

with  MWS-267945682 001 M-15223675 10 9 4 2 1.00 29/01/2018, 02:00:00 Processing
MWS-313201387 001 M-15223675 10 0 0 0 1.00 03/02/2018, 17:00:00 Processing
MWS-705997324 001 M-15223675 10 L] 0 0 1.00 29/01/2018, 03:00:00 Released
MWS-170627850 001 M-15223675 10 o 0 0 1.00 29/01/2018, 04:00:00 Released
MWS-187335773 001 M-15223675 10 [] 0 0 1.00 29/01/2018, 05:00:00 Released
MWS-502960280 001 M-15223675 10 o 0 [} 1.00 29/01/2018, 06:00:00 Released
~ovile.ze 90647 % Z9IUT12UT8, UT.0UUU 29IUTILUTE, VL0000
raining Target Setup Time (Operation) Actual Setup Time
00:10:00 -
Mat.No. | Material Tar per unit Timo per unit
21:32:16

Rosource Type
materialNumber-75235514971 - Manual workplace with sequential operation
materialNumber-83197532669 - Manual workplace with sequential operation

MES FLES

tity 'Scrap Quantity |Rework Quantity |Time Per Unit Planned Start Phase

OperationPersonTime OperationOverallPersonTimes | | OEEReportWorkp!
Huber, Mnrlon(54000001:- 101:23:42 123 Manualsaq 2001& = y = 89.88%, Per =5.33%, Quality = 66.67%, OEE =3.2%
Huber, Marion(54000001): 96:17:01

Huber, Marion(54000001): 52:11:13

Schlotterheimer, Gerd(54000002): 157:50:34

OEEReporWorkplace Charts

Availability: 89.88% Performance: 6.33% Quality: 66.67% OEE: 3.2%

Below the sample JS variables to be used for displaying report data is shown:

— = =71 ¥
DP_OPERATION_STATUS[®].description = "Producti

fo Dot (e o o D e nT1‘nr i Opea

..
on";

By Ry ha ha
[ =
& &

204

AI Report DperatlonPersonTlmes[B]

Report_OperationPersonTimes[@
Report_OperationPersonTimes[
Report_OperationPersonTimes|
Report_OperationPersonTimes|
Report_OperationPersonTimes[
Report_OperationPersonTimes|
Report_OperationPersonTimes|
Report_OperationPersonTimes[
Report_OperationPersonTimes|
Report_OperationPersonTimes|
Report_OperationPersonTimes[
Report_OperationPersonTimes|
Report_OperationPersonTimes[
Report_OperationPersonTimes[
Report_OperationPersonTimes|
Report_OperationPersonTimes[
Report_OperationPersonTimes[
Report_OperationPersonTimes|
Report_OperationPersonTimes[
Report_OperationPersonTimes|
Report_OperationPersonTimes|
Report_OperationPersonTimes[@]

]
2]
@]
2]
2]
@]
]
2]
@]
]
2]
@]
]
2]
]
]
2]
]
]
@]
2]

= new Object();

.reportiame = "OperationPersonTimes";

.5glResultRow
.SqlResultRow|
.SqlResultRow|
.5glResultRow]
.SqlResultRow|
.SqlResultRow|
.5glResultRow]
.SqlResultRow|
.SqlResultRow|
.5glResultRow]
.SqlResultRow|
.SqlResultRow]
.5qlResultRow]
.SqlResultRow|
.SqlResultRow]
.5qlResultRow]
.SqlResultRow|
.SqlResultRow]
.SqlResultRow|

[

a
a
a
a
a
1
1
1
1
1
2
2
2
2
2
3
3
3
.SqlResultRow[3
3

.5glResultRow[3]
var Report_OperationOverallPersonTimes = new Array();

Report_OperationOverallPersonTimes[8] = new Ob

Report_OperationOverallPersonTimes[
Report_OperationOverallPersonTimes[8].5qlResultRow
Report_OperationOverallPersonTimes[
Report_OperationOverallPersonTimes[@]

var Report_OEEReportWorkplace

Report_OEEReportWorkplace[@] =
].reportiName = "OEE
1.5glResultRow = new Array();
]1.5glResultRow[@] =
]1.591ResultRow[@]
]
]
]
]

Report_OEEReporthorkplace[@
Report_OEEReporthorkplace[
Report_OEEReportWorkplace[
Report_OEEReporthlorkplace|
Report_OEEReporthorkplace[
Report_OEEReporthorkplace[
Report_OEEReporthlorkplace|
Report_OEEReporthorkplace[
</scripts

= new Array()};
new Object();

.SqlResultRow[8].0
.SglResultRow[@].p
.5glResultRow[8].q
.SqlResultRow[ @]

]
]
]
]
]
]
]
]
]
1.
]
]
]
]
]
]
]
]
]

8] .reportMame = "OperationOverallPersonTimes'l;

8] .5qlResultRow[@] = new Object();
.5qlResultRow[@].personTime = "181:24:47";

.availability = "89.88%";

wiorkplaceId = "ManualSeq-20816™;

new Array();

= new Object();
firstName = "Marion™;
.lastMame = "Huber"; E
.personTime = "101:24:47";
.personnelNumber = "S54206081";
= new Object();

firstName = "Marion™;
.lastName = "Huber";
.personTime = "96:18:85";
personnelNumber = "S54868881";
= new Object();

firstName = "Marion™;
.lastName = "Huber"™;
.personTime = "52:11:13";
.personnelMumber = "54200081";
= new Object();

firstlame = "Gerd";

.lastMame = "Schlotterheimer";
.personTime = "157:53:48";
personnelNumber = "S4206002";

ject();

new Array();

ReportWorkplace™;
new Object();
ee = "3.2%";

erformance = "5.33%";
uality = "66.67%";

2.'-- ll"ISE'T"E \-"EF"!LBEIE Ee lﬂlE'J.OﬂE Eﬂb =
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Platform & Connectivity IMES FLEX

Creating a graphical view of the report data fetched is now possible within Operation Details View.
JavaScript library ChartJS (Version 4.3.0) and its plugin Datalabels (Version 2.0.0) has been added to
ffworker service as JS resources.

HTML code snippet to add the libraries while implementing the charts:

<script type="text/javascript" src="/ffworker/javascripts/chart.umd.4.3.0.min.js"></script>
<script type="text/javascript" src="/ffworker/javascripts/chartjs-plugin-
datalabels.2.2.0.min.js"></script>

FORCAM FORCE™ Operation [90270]

Workplace | Text Order Operation |Material No. | Target Quantity | Yield Quantity |Scrap Quantity |Rework Quantity | Time Per Unit |Planned Start Phase
eo270  BOZ

[VEnUSISE a0 VARSI WarpiacaWil | 1001000100 0010 M-15223675 2000 147 45 20 1.00 08/07/2016, 06:00:00 Interrupted
1001000102 0010 M-15223675 2000 0 0 0 1.00 0610712016, 06:00:00 Released
1001000103 0010 M-15223675 2000 0 0 0 1.00 06/07/2016, 06:00:00 Released
1001000104 0010 M-15223675 2000 0 0 0 1.00 06/0712016, 06:00:00 Released
1001000105 0010 M-15223675 2000 0 0 0 1.00 0610712016, 06:00:00 Released
1001000106 0010 M-15223675 2000 ] 0 0 1.00 06/07/2016, 06:00:00 Released

IDET, MArion(24UUUUU1): 18UT8 20
Huber, Marion(54000001): 52:11:13
heimer, Gerd( ): 380:00:03
French, Carin(54000111): 100:04:05

OEE Report: Workplace Quality by Reason Quality by Type Generic Process Data:
OEE Report 00270 5 REWORK mmmmm YIELD

!

80

) 0) (5 -

5 N =
=) 51 —

50 5

a

Figure: Screenshot containing various possible graphical views

— SCRAP

o

Conditions to enable SFT Template activity:

— Generic domain:
ActivityEnablerMethods.isCurrentProcessValueInRange("Humidity", "Factory Hall 1", 4@, 45)

= Workplace domain:

ActivityEnablerMethods.isCurrentProcessValueInRange("Pressure",
PKEY_OperationView_myWorkplaceId[0], 1100, 1200)

= Operation domain:

ActivityEnablerMethods.isCurrentProcessValueInRange("Pressure",
PKEY_OperationView_myOperationId[@], 300, 400)

() New methods introduced to manage activity button enabling in SFT.

DCU/DACQ

New method call is available in the DACQ-Script:
= Name: SENDPROCESSDATA

—  Variables: WPL, Name, Domain (GENERIC, WORKPLACE, OPERATION), Source,
MeasuredValue (double), Additional Text (String: max 32). The value of “Source” will be
ignored for WORKPLACE and OPERATION domain. See here for parameter details.

= Timestamp will be generated when sending
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Platform & Connectivity

Add new parameters to javis.ini section “messaging”:
—  bridgeApiAdress: IP-Adress of the BridgeAPI
—  bridgeApiPort: Port of the BridgeAPI
—  bridgeApiTimeout: Timeout for calling the BridgeAPI
= bridgeApiAuthUrl: URL to get access token
= bridgeApiClientld: ID of the client to authorize with
—  bridgeApiPasswort: Password for the authentication of the client (encrypted)

Result handling:

—  Log Success messages on DEBUG level (else, too much logging in case of many machines and
frequent data)

— Log Failure messages in ERROR level

— Case 1: Timeout
Messages have to be buffered internally and a sending has to be retried after 1
second

— Case 2: Error Code returned
Erroneous messages will not be resent

Script Examples

Send generic data:
SENDPROCESSDATA("@|WPL|@", "Measurement @|WPL|@", "GENERIC", "Source @|WPL|@", processValue, "Generic
@IWPL|@");

Send workplace data:
SENDPROCESSDATA("@|WPL|@", "WP Measurement @|WPL|@", "WORKPLACE", "-", processValue, "Workplace
@IWPL|@");

Send operation data:
SENDPROCESSDATA("@|WPL|@", "OP Measurement @|WPL|@", "operation", "-", processValue, "Workplace
@wrL|@");

Workbench

Shopfloor Terminal Template Editor
To configure standard report configuration to be displayed within operation detail view, navigate to
Operation View basepage > Operation Details > HTML Configuration:

= Inthe Operation Details > HTML Configuration > Report configurations, add one entry for
each URL.

— In Report configurations > Report configuration, provide the configuration Resource & Sub
resource from the standard report (from Webservice Editor in FFNewOffice).

— In Report configuration > URL Parameter list, provide the name/value pair if needed for
configured standard report. This name/value pair corresponds to a filter created within the
data source of the standard report. One URL may have multiple (or even none) name/value
pair. For each name/value pair, one URL Parameter list configuration needs to be configured.
The name/value pair consists of Name (corresponds to filter name in data source) and Value
(a static value or a dynamic value from internal input mapping).
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URL Parameter list may contain below type of filters/parameters:

List of Base Pages

Static key-value pair

Time range filter

Template Editor (Use Case 8n 9: Calling reports with API and process data )

Dynamic values (Workplace, Operation)

MES FLES

~ Use Case 8n 9: Calling reports with .

Operation (Operation View) | Ro

Reports (Browser)

Operation Production Status His

Base page configuration

Operation Table

Operation Details -

Background Activities

Time range values

Identifier QV A | Value
HTML Operation Block Template ra
~ Report configurations = E T
» Report configuration v )
» Report configuration ~ v ] F
» Report configuration A v OF
» Report configuration A~ QualityReport ice -
v Report configuration ~ icPr ita /
Resource name GenericProcessData
Subresource name
v URL Parameter st i Hements a——"_|configuration
¥ URL parameter ~ & URL parameter -
Name measurement
Value Humidity -
¥ Time range ~ @ Time range -
Filter Identifier (API) time

Set time range

Figure: Operation detail view — Report configuration

v Report configuration

~A v

GenericProcessDel

Resource name

GenericProcessData

Time Shift Day Week Month Quarter

Subresource name

® last 1 Month(s)

v URL Parameter list

(2) List Elements

v Include current month

v URL parameter

>

~ & URL parametq

Fixed time range

Name measurement from

Value Humidity to
v Time range ~ ~ & Time range

Filter Identifier (API) time

Year

OK Cancel

Time range values

= [timeTimeType=MONTH, timeRangeType=PAST, timelncludeCurrent..

Set time range

I

Figure: Report Configuration > Time filter > define time range
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System configuration purge the process data
Workbench system configuration (under Configuration > System > Purge Commands Configuration)
has been updated to have 3 additional table entries which can also be configured to purge the data

from configured tables.

MES FLES

stem
Object Update

Logging

Time Synchronisation |,

Decimal Format

Impor/Export
Production Tool Resources

Allowed Resources for Grooy Maximum Deletion Threshaid
Purge Command Configuration ~ Purge Detail

Table Name

Single Sign-an (S50)

LDAF Maming Schema

ntime Where Clause
ERP Maximum Deletion Threshald
ERP Download v Purge Detai
ERP Upload Tasie Hame
~ Fiter Active
Unused closed operatins Time Column
Data Lifecycle Management Where Clause
ERF Control Key Maximuen Deletion Threshoid

Hon-working Shift Generation

FR_DS_GENERIC_PROCESS_LOG

v

FR_DS_DOMAIN_PROCESS_LOG
v

s

FR_DS_PROCESS_CS

v

DOMAIN_TYPE = ‘OPERATION

2160:00:00

2160:00:00

2160:00:00

The default threshold for purge is 90 days and FR_DS_PROCESS_CS is only purged for domain_type

‘OPERATION’.

Office Client

Path: System Administration > Shopfloor Connectivity

In order to define the caching time for reverse proxy, the new configuration is added “Cache TTL”
when add/edit the Webservice. The cache value is defined in seconds.

/ﬁ‘ ~  System Administration +  Shopfloor Connectivity +
Webservice Editor SQL Browser Filter Criteria Data Formats
0 © New Save (1 Copy & Import Test

GenericProcessData Editor Preview Webservice

HumidityMeasurement zz TTUNl 1T _US_Prucess_1Ug_gSicl IC roy

OEER Workpl 23 Where @veasurementSource(Measurement_Source)

eportiWorkplace 24 and @time_filter(Ts,Ts)
OperationOverallPersonTimes 25 and @Measurement(Measurement)
OperationPersonTimes 26 ) GPD
27 order by TS DESC

PressureMeasurement

QualityReportWorkplace

standardreports/hitlistoperatingstatesmat

standardreports/hitlistoperatingstateswor

standardreports/hitlistqualitydetailsmateri

standardreports/hitlistqualitydetailsworkp

standardreports/overallequipmentefficien

standardreports/overallprocessefficiency Collection

standardreports/qualityreportmaterial

P /9 -ty P Items Column Identifier (SQL) Rl

standardreports/qualityreportworkplace

standardreports/sumquantitiesoperation MEASUREMENT _SOURCE measurementSource
MEASURED_VALUE measuredValue
ADDITIONAL_TEXT additionalText
Ts ts
MEASUREMENT measurement

Cache TTL 1000
16 elements found
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Platform & Connectivity

Inclusion of split information in FORCE MES FLEX messages

Affected module Affected area Status

ERP Connectivity / BridgeAPl | ERP Connectivity / BridgeAPI New

With every message from FORCE FLEX MES, the split information will be included and sent. The split
information is independent of if the split was performed in MES or ERP.

<OperationSplitIndicator>false</OperationSplitIndicator:>
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Extension of Delta-Export (filtering)

Affected module Affected area NI

PDM/DNC Delta-Export New

Delta export can be now configured with filter configuration. This filter configuration is used to
define a custom export which results in only those data being exported which matches with the
configuration.

Configuration

New Filter Tab is developed to filter the delta export. User can add/delete the filters with the help of
or B buttons at row level.

Based on the filter type, the filter value selection is adapted. For example:
= Workplace filter type shows the workplace selection filter.
= Multiple selection is enabled for filters Material & Packet State with selection dialog.

= For the other filter types, user can set the string with wildcard characters.

Delta-Export I} Configuration

Configuration Pages

Mame DeltaA FTP Activated ' No v Root Directory | D:\PDM-FOM\Delta-Export\De
Delta A ) i ) porty
sermame

le  Emergency Mode e

Directory structur Filters

Packet Name: - 0 [+ N -]

Workplace v 90270 08

Material No. ~ 299033205 | Rear Flap; 1800203178 | Verstellhuelse L=82.5 -a|

Export functionality

The export will only be executed when a packet satisfies all the filter configuration, i.e., a packet has
to satisfy AND condition. For example, all the packets will be exported if they meet the required
criteria with workplace “90270” and AND packet state “Released”.

Multiple selection is enabled for filters Material & Packet State. When these filters allow multiple
selections, a packet has to satisfy the OR condition. For instance, packets will be exported if they
have either “Mat-01" or “Mat-05" as the material and they meet the OR condition.
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Appendix

Abbreviation/Term  Meaning

API Application Programming Interface
DB database

DNC Distributed Numerical Control
DPB Digital Planning Board

ERP Enterprise Resource Planning
MDC Machine Data Collection

MES Manufacturing Execution System
NC Numeric Control

NCP NC Program

PDM Production Data Management
SFT Shopfloor Terminal

sQL Structured Query Language
UuID Universally Unique Identifier
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